HIST 133B BOOK ESSAY ASSIGNMENT I: BOOK PROPOSAL

Proposal with reviews (due Jan. 22--week 3)

§1. What should I write about? How do I find an appropriate book?

- Think about Germany between 1900 and 1945--what interests you about it? Look through the readings and textbook for ideas. Once you've thought of some topics, look through the list of books in the textbook (Bergen, 231-241) on the course website, and pick a book. If you can't find one you like:
- Broad topics: World War I, 1918 revolution, Weimar culture, politics and economics, biographies of famous or "ordinary" Germans; Nazi or other political parties, foreign policy, social or other groups (workers, Jews, women, gypsies, gays, Christians, ...), resistance movements, youth, important events (Night of Long Knives, Kristallnacht, ...), concentration camps, ghettos, ...
- Go to the library and browse the shelves: DD240-256 are the main relevant call numbers.
- Search amazon.com for keywords, and following the "recommendations" and "also bought" link.
- If you have trouble thinking of a topic or finding a book, please come to talk to me—sooner is better!

§2. What kind of books are suitable? I would prefer that you select academic/scholarly works of history (these have foot- or endnotes), and not anthologies (collections of essays) or fiction (novels), although I sometimes make exceptions. Many memoirs, diaries and biographies are fine as well.

§3. What should my proposal look like? The purpose of the proposal is to be sure your book is suitable, and to prepare you for writing your essay. It has four main elements:
1. A descriptive title that indicates the main theme you are interested in.
2. Full bibliographic information on the book, including the publisher and number of pages, as well as the library call number or other information on the availability of the book. Write explicitly whether you have a copy, have merely seen one (amazon, google books), or how you will get one--if approved.
3. A 1-2 paragraph description and explanation of your topic, and an explicit list of questions that you want to find out about and hope the book will address.
4. Published reviews of the book, with annotations.
- You should attach printouts or photocopies of 2-4 reviews of your proposed book, at least one of which should be from a scholarly journal (which may be available on the internet, but you may have to photocopy it from a hard copy journal in the library).
- As part of your proposal, for each review you must give full bibliographic information (author, journal title, date, page numbers; and, if from the web, also the website or URL). A URL alone is not enough--jstor and ebsco URLs are meaningless here.
- Include after the bibliographic entry a short annotation summarizing each review.
- For books published since 1987, reviews in scholarly journals are often listed in the Academic Search Complete, accessible from the UCSB domain, through the library's homepage (Research, Article Databases: www.library.ucsb.edu/eresources/databases/). The actual review text may not be available on-line, so you will have to get that journal from the stacks and photocopy the review.
- Be sure to search books.google.com. In the About tab, on the lower right, reviews are listed. Those with pay access are often available through the UCSB library website for free.
- If you need help finding reviews, ask a reference librarian for help, or see me.

§4. Due date: Thu, Jan. 22. Late submissions will be penalized one point per day, beginning at 3:30pm.

§5. Plagiarism—presenting someone else's work as your own, or deliberately failing to credit or attribute the work of others on whom you draw (including materials found on the web)—is a serious academic offense, punishable by dismissal from the university. It hurts the one who commits it most of all, by cheating them out of an education. I will report offenses to the appropriate university authorities for disciplinary action.
HIST 133B BOOK ESSAY ASSIGNMENT II: ESSAY GUIDELINES

I. Book essay (due Feb. 17--week 7)

§6. Once your proposal has been approved, you should

- Read the book, taking notes about its main argument (the author's thesis--can you find a thesis statement?), the sources s/he uses in each chapter, and how the book is structured.
- Write a short introduction about the main question(s) your book addresses, and the answers it offers. Be sure to mention what sources the author draws from. This is the place for your thesis statement assessing the author's main argument or point (i.e. the author's thesis). (See separate handout.)
- In the main body of your essay you should integrate a descriptive overview of the book with a discussion of how convincingly the book argues its thesis. Conclude with your assessment of the book's significance.
- Please resubmit your proposal when you submit your book essay--attached in front of it. Include the photocopied reviews only, but not thick photocopied articles.

§7. Content/Grading. When I grade, I look for five things.

1. First, your thesis statement tells me not only what the book is trying to argue or explain, but also your assessment of that thesis. Mark it in boldface type.
3. Third, I look for concrete evidence—specific cases or examples—used to support that argument. A paper with any two of these three is a "C;" all three elements earn a "B."
4. Fourth, I look to see whether counterevidence is discussed—whether you refute evidence that supports a thesis different or contradictory to the yours. If elements one, two and three are also present, this would bring a paper into the "A" range.
5. Finally, I look to see whether a paper is carefully written and proofread, and has clear organization or perhaps even stylistic grace. This can lift a paper up to a "+" or, with two or more typos/errors per page, drop it down to a "-.

§8. Length. Your essay should be at least 1800 words—6-7 double-spaced, typed pages, with 1½x1½x1½" margins and 12 point, proportional space font. In Microsoft Word, select the body text of your paper. Use Tools > Word Count, and insert the resulting number after your name at the top of your paper. Number the pages! By hand is ok if you are word-processor challenged. Otherwise one point off!

§9. Due dates. Late submissions will be penalized one point per day, beginning Tuesday at 3:30pm.

§10. Grading. The book essay counts for 20% of your final grade (30% with the proposal and corrected version). It is worth taking seriously!

§11. This course fulfills the general education writing requirement. If you do not submit all parts of the book essay assignment, you cannot receive credit for this course (i.e., you will fail).
II. Grammar Conventions (& Pet Peeves)

1. The book and book author's voice should be in present tense; historical events in past tense.
2. Do not use the collective singular (with a definite article) to refer to groups; use the plural instead.
   E.g. not "the reader will notice . . .," but: "readers will notice." This not only indicates that not all readers are alike, but enables you to use "they" instead of having to choose between he & she.
   Similarly for the historian, the Nazi, the Jew, the German, etc. This helps to avoid stereotyping.
   Exception: when you do want to stereotype: "the common German citizen" (still a bad practice).
3. Place apostrophes correctly; do not use an apostrophe for pluralization (unless the word is possessive):
   One Nazi, two Nazis. But possessive: That Nazi's gun; that group of Nazis' guns.
4. Capitalization of west/western, east/eastern: only when these are being used to denote the blocs during the Cold War, not when purely geographic. Note: Fulbrook does this wrong.
5. Try to avoid the use of "America" (which can mean two continents) when you mean United States.
6. Recently, the convention for spelling antisemitism has changed: no hyphen or capitalization. (This recognizes that there is no such thing as Semitism. [See Bergen, War & Genocide, p. 4.])
7. Do not use an apostrophe when referring to decades, e.g. "from the 1920s to the 1930s."
8. Use "who" when referring to people, "that" when referring to things or organizations.
9. The past tense of lead is spelled led: The leader Moses led his people to the promised land.
10. A novel is a work of fiction; most of your academic books are monographs or simply books.

III. Formatting Preferences & Conventions

11. The thesis statement (and any subheadings) should be marked in boldface type.
12. Use in-text citations only (Authorslastname, #), e.g. (Ash, 23), not footnotes.
13. Place punctuation marks inside the "quotation marks," but page citations outside of the quotation marks and preferably at the end of the sentence, not right after a quotation. Thus:
   When prisoners gave up hope, they were called "Musselmanner" by the SS (Dwork/van Pelt, 218).
14. Set off quotations longer than 3 lines/40 words as block quotations: single spaced with .5" left indent.
   (Do NOT use tabs to do this; rather: Format > Paragraph; then select Left=.5 and Special=none. Or just click the right indent icon on Word's Formatting menu bar, if you have it visible: 

   15. Use only italics for emphasis and titles, never underlining. Underlining is reserved to signify links.
16. Use italics for book and journal titles, put "journal article titles" in quotation marks.
17. If you want to insert an aside--like why should you care about this stuff--use double hyphens, no spaces.

IV. My Edit Markings

a. dot under a letter: change capitalization (if lower case, capitalize; if capital, should be lower case)
b. ¶ means start a new paragraph at that point
c. [ ] text can be deleted; ( ) I think another formulation would be better--your call
d. _____ ﹀ (line with curl at end): words or letter(s) should be deleted.
e. awk. Awkward formulation, please rephrase.
f. … under some editing marks: my mistake, just leave as you had it.

V. Revised version (due Tuesday March 3) [changed to Thursday March 5]

§12. I will return your paper with comments and suggested corrections. You should correct the items noted, both marking the hard copy and describing on a separate sheet (attach it to the front) how you would change your essay to improve it along the lines I suggest. Include rewritten paragraphs as necessary.
If I have suggested extensive revisions, you may need more than one sheet, or even a fresh printout.
§13. Note that if you earn a B+ grade or better, you may opt for web publication instead of a final exam.
I will provide a separate handout with the guidelines for the web option.
**HIST 133B: PAPER REVISION & WEB OPTION GUIDELINES (III)**

To submit on Thursday, March 5, 2009 in class (Mar. 3 for Web option Conditional):

A. **Web option NO:** If you did not qualify (B+ minimum), or do not want to do the revisions needed in order to qualify for the Web Option, or if you qualified but choose NOT to do the Web Option, you should submit:

1. The graded **hard copy** I returned to you, with the following: **describe/note in a different color pen, pencil, or marked with highlighter any changes you are making.** If you substantially rewrite a paragraph, write "rewritten, see #[x]" in the margin, where [x] is a number marking that rewritten passage on a separate, new printout ONLY of the revised paragraphs or passages.
2. If you are making substantial changes throughout, submit a new printout with all changes, **as well as the old marked-up version.**
3. Write "**Taking Final Exam**" at the top of the first page.

B. **Web option Conditional:** If I said you could still qualify for the Web Option if you did some additional work, do 1 & 2 as above, and **note at the top** of your graded essay's first page that you are trying to qualify: "**Resubmission to qualify for Web Option,**" and **include your e-mail.**
I will let you know asap whether you qualify, so you can start on the items §1-6 on back.

C. **Web option YES:** You do **not** need to submit your corrected paper yet, UNLESS you are making major changes to certain text passages, especially your thesis paragraph(s). If this is the case, please make a separate printout as in A. 1 & 2, above (for me to copyedit).

1. Submit a **printout** of the additional items §1-6 below (on back).
2. Write "**Web Option**" at the top of the first page of any separately printed corrections.

**WEB OPTION GUIDELINES**

I. **Procedure** (If you choose to do the web option instead of the final exam, you must do the following:)

1. **Write and submit** in **hard copy** §1-§6 in II, below. **Note that §5 is especially important** (lion's share of grade, namely 20 of 25 points)! These are due on **Thursday, March 5, 3:30pm in class.**
   - I will edit and grade them, and return them to you on Tue, March 10.
2. **Prepare your book essay file** as follows:
      [Year is the date of your book's publication; 093 stands for 2009-March.]
      If you don't use MS Word, .rtf (rich text format) is ok, too. (Under File > Save as, select "type.")
   b. In that computer file, make revisions and corrections. On the graded **hard copy** I returned to you, **please describe/note in a different color pen, pencil, or marked with highlighter any changes you are making, and check off** the small copyedits I marked as you fix them. If you are substantially rewriting a paragraph, write "rewritten--see changes on separate printout" in the margin.
   c. After you get the items of II, §1-§5 back, **correct them and insert them at the beginning** of this file.
   d. Upload items §1-§5 on my Hist 133b web site. I will supply the link to the upload form to you.
3. On **Thursday, March 12 in class:** Submit the marked (by me and then by you) **hard copy** of your essay and the **marked & corrected hard copy of the items II, §1-§6.** **Don't forget to sign the pledge.**
4. **Image:** Try to find one image for the web page header. You may insert it into the word document, **but it must also be saved as a separate file**, named as follows: AuthorslastnameDescriptiveword.jpg [.png also ok]. For example: HerfBookcover.jpg. It must be saved and uploaded as a separate file. A vertical format is best, 300-600 pixels high. Give me some caption information with your essay, if necessary.
5. Upload the augmented supplements+essay computer file (named as in I.2.a), and an image as a separate file (even if it is in your essay file) by **8pm on Thu. Mar. 12** to the **Gauchospace** website.
II. Web Option Supplements §1-§6

Your final submission must have the following elements in addition to your book essay text:
(For examples, see the "Index page of student essays," in the menu bar on my 133b course web site.)

§1. Think of a meaningful title for your essay--it should indicate your "angle" on the book you read:
"Descriptive Title in Quotation Marks"
"Assessing the Role of 'Ordinary Germans' in Genocide"
by Yourfirstname Yourlastname

by Jane Doe

§2. Full author name, Title, and (publication information) of the book on which your essay is based.
This should be in the following form (do not put each item on a separate line; I'll do that):
Authorsfirstname Authorslastname, Title: Subtitle in Italics (CityOfPublication: Publisher, yearpublished),
number of pages. UCSB call number. [include the call number even if you did not use the library copy]

§3. An About the author sentence or paragraph, in which you describe: yourself (major, class year, relevant interests), and (as appropriate) why you are interested in and the extent of your knowledge of German/European history (e.g. personal/family connections, previous coursework, travel). You should also say why you chose this particular book or topic.
Example: I am a junior psychology major who has been studying group dynamics. I traveled in Europe after high school and spent two weeks in Germany, including visits to xx and yy in Berlin. I chose to write about Gellately's book because I am interested in what life was like under the Nazi regime, in particular why so many Germans were willing to participate in genocide.

§4. An abstract of your essay, about 150-200 words, in which you briefly describe what the book is about, and state the author's and/or your main thesis (the main point the book makes, and what you say about it).

§5. An annotated Bibliography and Links section, with that heading, and 3 subsections:
i Book Reviews of your book, with the full bibliographic information, including a link if available online. If the review doesn't have its own title, use: "Review of Bookauthorslastname, Short Title."
ii Web Sites: the 3-5 most relevant links you can find. Note: do not merely take the top search results, but review at least 15 links found using several different search terms before selecting the most relevant.
iii Books and Articles. You should list at least 2 other books or journal articles on your topic. The Google books (books.google.com) About this book tab, "Related Books" section (scroll way down) is a good place to start; see also the "References from ..." sections.

• Each item must have an annotation--a brief description and assessment of that web page.
For examples see my website for Hist 133b in previous years, and my other Hist 133 courses.
Also, google annotated bibliography. I recommend the Cornell library page, and the UW-Madison site (see esp. the types+linked examples on the "What goes into the content of the annotations?" page).
• Format for these entries. Use one bulleted paragraph for each entry. After the end of the bibliographic information, start a new line using <shift+enter>; do not use <enter>.
• Web page citation format: Author[if known, or site/institution], "Web page title [if available] in quotation marks" (creation/revision date[if known]), <URL>.
  o You can enter the URL at www.archive.org to get an approximate date when the page was created.
  In that case give the date as, for example: (archive.org: Jan. 2004, last revised May 2007).
  o For Wikipedia articles (which have no author), just use the word Wikipedia in place of the author's name, and place the "article's title in quotation marks" (accessed Feb. x, 2009).
  o For books you should include either a library call no., or an amazon or google books link.

§6. The following pledge, followed by your signature (on the hard copy only):
I certify that this essay is my own work, written for this course and not submitted for credit for any other course. All ideas and quotations that I have taken from other sources are properly credited to those sources. I agree to web publication of this essay. YOUR SIGNED NAME

VI. Timeline
March 5 (Thu.): submit hard copy project elements (and possibly substantial changes to essay).
March 12, 8pm: upload supplements on Marcuse's web form; upload essay and image file on Gauchospace.
March 20: proofread online essay (including formatting), check all internal/navigational links and external links (including hyperlink on index page and title bar), confirm and note corrections on Gauchospace.
§7. The text of your essay, already corrected as noted on the hard copy. Please do not use underlining, only bold and italics (underlining is only for links). Subheadings are a great idea--try to find appropriate ones for the sections of your essay. For headings, use a separate, left-justified paragraph in boldface type.

VI. Grading

This project, like the final exam, is worth 25 points. I expect an equivalent amount of work to what you would do for a final exam. Up to 20 points primarily for §5; up to 5 more points for following the instructions properly.

- You will receive annotated sources section (the list of books, articles, and links).
- You will receive up to 5 more points for submitting the items §1-4 and meeting the deadlines, when you confirm that your web page meets the following standards:
  a) Your name and the essay title on the index page and in title bar of browser window are correct.
  b) Your About the author and Abstract sections are correct.
  c) All navigational and external links work (library databases [jstor, ebsco] should be checked at UCSB).
  d) Your online text has been proofread and has no grammar, spelling or formatting errors.
- Ideally, hopefully, this confirmation should happen by the final exam time (Mar. 20), after I've uploaded your page.